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 INTRODUCTION 

 
 

 TEM-RESEARCHER (TEM-RES) program is intended for modeling and inversion of 

soundings by determination of field (transient) data, obtained with usage of the ungrounded 

horizontal magnetic antennas (loops) in two configurations: 

- single loop configuration - one loop combines functions of the transmitter and  receiver, 

 

- two-loop configuration - transmitting and receiving loops are coaxial. 

 

 TEM-RES v.8 supports TEM-data formats acquired with the following tools: 

 - TEM-FAST PROSYSTEM 

 - TEM-FAST 32 

 - TEM-FAST 48 

 - TEM-FAST 48 HPC 

 

TEM-RESEARCHER program distinguishes with a number of the possibilities ensured 

with a friendly interface: 

1)   the editor of the initial data which allows to estimate quality of the field 

measurements and to correct the poor-quality data or to exclude them from the further 

processing and interpretation; 

2)  modern set of applied tools which gives the possibility to choose the optimal number 

of layers in a section and to determine their parameters; 

3) possibility of including some non-conventional parameters to the model, such as 

frequency dispersion of conductivity and dielectric permittivity, induced polarization (IP-

effect) and superparamagnetic (SPM) effect; 

4)  opportunity  to  adjust the inversion  procedure  on  the  basis  of  an  a  priori  

information  on  a geoelectric section by limiting an allowable range of changing of such 

parameters of section as thickness, resistivity or IP parameters; 

5)  multipurpose and effective tools for drawing the geoelectric section on a basis of 

array or  profile TEM-information; 

6)  opportunity to transfer the graphic information to any MS Office program and other  

programs as standard EMF files (Windows Enhanced MetaFile); 

7)   possibilities for completely automatic (or semi-automatic) processing of large arrays 

of data (hundreds and thousands). 
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 INSTALLATION OF THE PROGRAM 

 

  The program is designed for a Windows 95/98/ME/NT/2000/XP/WIN 7 and is delivered 

as a unit of executed TEM-RES.exe code, the package of drivers and the electronic USB-key 

which protects the user from viruses and unauthorized distribution of the program.  

  Installation of the program is reduced to opening of a new folder (for example, TEM-

RESEARCHER) to copy TEM-RES.exe file and dynamic Novex32.dll library in this folder. 

Further it is necessary to install the driver which supports the operation of a USB-key 

(DRIVERS\instdrv.exe on your CD). If the driver is installed correctly, the green light on the 

end of an electronic USB-key flashes. The program is ready to operation.  

 The serial number of the product is indicated in exposition, and also in the window             

About TEM-RES of the main menu. 

  

 THE MAIN MENU 

 

Double-click by the left-hand mouse button on TEM-RES icon to call the main menu. The 

TEM-RESEARCHER window will appear on the screen:  

 

 

 
 

Fig. 1 
 

It is possible to minimize the window in an icon or to maximize at the all screen to make it 

more convenient, or to delete it using the reference resources of Windows    located 

in the right upper corner of the main window. 

?   
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 DATA INPUT 

 

Click once by the left-hand mouse button on File in the left-hand upper corner of the main 

menu. You also can use Alt+F buttons instead of the mouse. 

 

 

Fig. 2 

 

 From the appeared menu select data input (Input Field data E (t)) and press the left-

hand button of a mouse. Standard Windows file dialogue will appear on the screen. In this 

window you may choose the necessary file in a TEM-format containing the data of 

soundings. 

The program supports the following types of files containing the initial tem-information: 

- Text tem-file (1996, 2002 formats) 

- Binary tem-file (copied, but not converted from  Handheld PC) 

- Int-file containing 1D inverse data (1996, 2002 and 2008 formats) 

- Psc-file containing data of conversion (1996, 2002 and 2008 formats) 

- Sec- file containing 1D inverse and conversion data (2008 format) 

Further the TEM-data of a single sounding we shall name “set”. 

 After the file is opened, the window in which you can view the information about the 

file and select data for the subsequent analysis will appear. There is a copy of an 

information window in the left bottom corner. The loaded earlier sets have square marks 

(set 020А). 



6 

 

 

 To delete set double click on its name. In total you can select up to six sets of soundings 

which will be shown by different colors in a frame in the left bottom corner. 

     The information on coordinates of sounding points is displayed аt pressing XYZ 

button in column Remark Activation of Map window (Fig. 3) visualizes layout of 

soundings points on a topographical map (Fig. 4a). 

  Style window allows changing a coordinate system: 

 Math (mathematical) - the X-axis increases from left to right, the Y-axis increases from 

below up.  

 Geo (geographical) - the X-axis increases from below up, the Y-axis increases from left 

to right. 

 Grid - setting of a grid according to the selected step. 

 Label - setting of a number for a point corresponding to the first column on Fig. 3.  

 Altitude - setting of Z values (elevation). 

 Name - setting of a name for a field point (Set Name) 

 

 

 

 

 

Fig. 3 
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Fig.4a 

 

 If the input data contain points with equal coordinates X and Y (repeated, check 

measuring or wrongly entered coordinates), they are meant as the imposed quadrates on a 

map. 

Zooming: holding the left-hand mouse button, draw a rectangle, after pressing the right 

button the selected fragment of a map will be enlarged (Fig 4b). Sets outside a selected 

rectangle become "inactive" and grey. 

 

 

Fig.4b 
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Zoom out button is intended for return to an initial state. 

Opening Save Sets menu allows to convert and save data from open TEM/INT/PSC/SEC 

file to: (see section « Conversion of data ») 

- tem-file 

- int file 

- psc file 

- sec file 

- MAP_E - (for Map) file has table form: in columns - values E(t)/I for each time t, in 

lines - points of soundings (see formats of files). 

 Only active sets of soundings colored with black, will be recorded to the new file (Fig. 

4b). 

 Clicking with the right mouse button on any set, it is possible to make it active (black 

color) or inactive (grey). 

Double-clicking with the left mouse button to any set allows to receive the complete 

information on sounding and to edit some parameters (Fig. 4с). Controlling buttons "+" "-" 

"<" ">" allow to change smoothly location of sets on the map. 

 

 
 

Fig. 4c 

 

Let's return to the Fig 3.   

 Sort menu allows to sort data by: default, time of making, name, X coordinate, Y 

coordinate, Z coordinate.       

 The window “Use current cut-off Delay ” is intended for auto correction of field 

measuring data taking into account a real front of a current turn off in a generating contour. 
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 Auto Inversion button is intended to launch the system of auto 1D inverse of all sets in 

an active file (it is active only in special versions of the program). 

 Auto Transformation button intended to launch the system of auto construction of 

pseudo -sections (see the section “smoothing the data”). Before the beginning of this 

procedure it is necessary to set a number of parameters (Fig. 5) 

 

 

 

 

 

 

 

 

 

Fig. 5 

  

 If there are some points with equal coordinates in a data file, then: 

use First  - only the first point under the order of recording in the file is used; 

use Last - only the last point under the order of recording in the file is used; 

use All records - all points in the TEM-file are used. 

 Parameters Smoothing and Res (h) Resolution are described further in appropriate 

sections. 

Delete Topo - the user can delete a contour of a surface, having assigned for all points Z=0. 

By default pseudo-sections for each point are created taking into account an elevation, given 

in initial data. 

   The automatic mode construction of pseudo-sections is used at a large volume of 

homogeneous initial data. 

 If there is a data file obtained at array researches (several hundred or thousand points), we 

recommend: 

- to test attentively a regularity of the points coordinates definition and if necessary to correct 

data; 

- to select suitable and to delete unnecessary (iterating) sets; 

- to load dozen curves of soundings from different parts of the area and to select common 

modes of smoothing (Smoothing) and permissions (Res (h) Resolution) for them; 

- to start the mode of automatic construction of pseudo-sections. 

 If the data containing the information on soundings are loaded from the INT-file (2008 
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format), as a result of automatic conversion it will be the SEC file containing 1D model of the 

environment, and conversion (see the format of files)    

 After choosing the necessary sets of soundings (Fig. 3) and pressing the Input button, a 

pattern shown on Fig. 6 appears on the screen. 

 

 
 

Fig.6 

 

In a right part of the screen the different forms of representation in which it is possible to 

represent selected data are shown. Here Res(t) is apparent specific resistivity a(t), E(t)/I is 

EMF in a receiving antenna or t*E(t) is a signal or a resistivity multiplied to time. Physical 

dimension of data on diagrams is shown on the left vertical axis. 

Having pressed Err button, it is possible to display the information on errors of definition 

Res(t) or E(t)/I as confidence intervals (  3*STD - standard deviations). 

 Line function allows to present experimental data as points or interpolate them as piece-

linear curves. At wish, it is possible to plot more detailed grid to the figure, for this purpose it 

is enough to press Grid. 

The buttons  located in the beginning and in the end of coordinate axes allows 

changing scales and layout of diagrams on the screen to make them more convenient. 
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Some points on experimental curves can have sometimes the negative sign (for example, 

at IP-effect). In this case such points are not displayed on diagrams; however they can be seen 

with the help of Abs function.  

The button +/- allows to display transient process E(t)/I in a special scale with two 

logarithmic axes for the positive and negative part of the process. Position of a zero level "0" 

can be adjusted with the  buttons located near the right boundary of diagram (appears at 

activation +/-, see Fig. 6 а). 

 

 

Fig. 6a 

 

ATTENTION: 

If it is necessary to copy the screen, it is convenient to press ALT+T- before this 

procedure, 

all control elements disappear from the graphics. Repeated  ALT+T restores control 

elements. 

For convenience of the further processing and analysis the interpretive program one can 

select one or several curves from a data set, and delete data which block up the screen. For 

this purpose it is necessary to call Info function:  
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Fig. 7 

 

The SOUNDING INFORMATION window (Fig. 7) with titles of selected files and the 

information about soundings will appear: 

Tr, Rec - size of transmitting and receiving antennas 

Stc - the parameter of accumulation ("stack") 

Time -  time range of measurements 

HVP - adjustment of the HVP-system (in microseconds) 

F (Hz) - industrial noise filter 

I (A) - current in the transmitting loop in amperes 

dT (ns) - correction parameter of current turn off front in the generator loop (delay of a 

current impulse turn off front in nanoseconds) 

 Double-click the left-hand mouse button the set which you want to delete to the buffer, 

and it will disappear from the screen. The repeated operation will return the file from the 

buffer to the screen. 

This operation can be realized with the help of Alt+1, Alt+2… on a keyboard.  

Make active Sounding Info window (click the left-hand mouse button in any place of the 

window). Pressing Alt+A deletes all (All) sets of field data from the screen. 
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  SETTING OF THE SECTION MODEL PARAMETERS 

 

 

Having pressed to Model function, an interpreter can go to the window of models MODEL 

which allows controlling the main process of direct and inverse problems solution. By the first 

call the window always appears in the right bottom corner. Press "?" to get manual for 

operation with the window - Fig. 8. 

 

 

Fig. 8 

 

 Let's consider in detail the operation with this window.  

The window is constructed as the table. In the first column the value of resistivity for 8 

layers of a model in Ohm-m, in the second one - thickness of these layers in meters is 

represented. Color rectangles with small squares inside correspond to model which is active at 

present, and can be activated by left button click. Change of a small square gives in 

replacement of current model by activated one (on Fig. 8 the first model highlighted by red 

color is active). Control elements of the window are as follows: 

   - this control element is used for: 

- inserting a new layer to the model (left mouse button), 

- deleting a layer from the model (the right mouse button); 

   - this control element is used for increase (upwards) or decrease (downwards) values  

   of the model parameters with step  or h (steps are determined in window Setting  

         Modeling); 

 - this control element is used for alignment of model resistivity, starting from the 

chosen  layer.  
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The results of activation of this element on layer N3 are shown in the figure. In other words, 

the function  allows to combine all underlying layers in homogeneous half-space and 

to consider them during further processing as the homogeneous basement of a section. 

                      - buttons to start the single calculation of model and the inverse procedure. 

                               - the panel of the active model choice. 

 

After RUN or Inverse appropriate operations for selected model are fulfilled. 

 

Operations: Pressing  keeping  moving  releasing of the right mouse button gives 

in copying of all parameters from start (at pressing the button) models in target (release of the 

button) model. 

 

 ATTENTION! 
 

1.  MODEL window appears on the screen in shorthand form (6 left columns). Standard 

for WINDOWS procedure of "spinning out" by the mouse allows receiving the extended 

alternative of the window. Besides the user can reduce a vertical dimension of the window, 

but with loss of some layers. The function of the right (hidden at initial loading) part of the 

window we shall consider later. 

2. The amount of model layers is calculated starting from the bottom layer. The 

calculation starts from the moment of when the difference in resistivity of i and (i-1) layer 

exceeds 1%, i.e. ( i- i-1)/  i > 0.01. For example, model with resistances (starting from 

surface): 10, 20, 20, 1000, 1001, 1005, 999.9, 1000, will be considered four-layer, the last 

four layers are skipped. At the same time intermediate layers with equal resistances 20 Ohm-

m are not combined but calculated separately, as two separate layers. 

3.   During the inversion,  situation when visibility of layers is less than 1 % can take place, 

however the program does not reduce a number of layers automatically.  

4.   At start Inverse the inversion procedure starts calculations for model, prescribed in 

MODEL window, the number of layers during calculations does not change.  

5.  The user can delete a graphics, appropriate to model calculations, pressing the keys 

"Alt+1", "Alt+2", … "Alt+6" if Model window is active (is positioned in focal point). 

Pressing Alt+A gives in deleting all models.   
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 MODELING 

 

 Before the beginning of modeling, it is necessary to set receiving/transmitting antennas: 

size of loops, number of turns. These parameters are set in Setting   Modeling window of 

the main menu. 

 
 

Fig. 9 

 

    The window for setting the modeling parameters determines: 

    -  activity/passivity of models (in this case models No 1-3 are active, and 2,4,5,6 are 

passive).    The user can deactivate model with click to an appropriate quadrate in the left 

column of the window. At the same time « model curves » will disappear from all 

diagrams.; 

    -   name of the model; 

  -   size of transmitting and receiving antennas and number of turns; 

 

    -   Resistivity step (r.un.) is step of the resistivity changing in the MODEL window at  

        activation  of the  control element                      . 

 Resistivity of the layers change according to the formulas:  

   или , =1.01  (by default). 

     - Thickness step (m)               is h step of the layers’ thickness changing at activation of    

       the control elements. 
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The thickness is changing as h=h+ h or h=h- h, h=0.5 (by default). 

- Width of pen (pixel) is a thickness of the lines on diagrams in pixels of the 

screen. 

 

 

ATTENTION: 

If there are field data on the screen, the program automatically installs Name, Tr, Rec, 

Turn according to parameters of field data sets. 

 

Change, if it is necessary, parameters Name, Tr, Rec, Turn and start modeling. 

 For direct problem solution it is enough to install parameters of section in MODEL window 

and to click in the same window button RUN. In the main window the colored curve, 

appropriate to color of the activated small square Model located in a bottom line of MODEL 

window will appear.  

 

ATTENTION: 

 

Unnecessary at present graphics of model curves can be deleted from the screen, if 

- MODEL window is active (the top stripe at the window is dark blue or blue) 

- Pressing ALT+1, ALT+2 … ALT+6 - appropriate graphics will disappear 

- ALT+A-all graphics will disappear. 
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 EDITING OF EXPERIMENTAL DATA 

 

Let's consider now the procedure for the analysis and edition of experimental data. Let's 

select for instance a curve of the apparent resistance complicated with an error. 

 

 

Fig.10 

 

 For correction of outliers on a curve (Fig. 10) it is necessary to use sequentially the  

Edit  Edit field data functions. In the appeared window mark a curve which should be 

corrected (in this case the dark blue curve is activated).  

-  For excluding a point it is necessary to choose it by cursor of a mouse, simultaneously 

press the key Ctrl and the left mouse button (color of a point becomes grey). 

- To change a sign of a point (at active Abs option) it is necessary to choose it by the mouse 

cursor, simultaneously pressing the key Ctrl and the left mouse button. 

-   To change position of a point it is necessary to choose it by the mouse cursor, press the 

  left button of the mouse and to move it (upwards - downwards), not releasing the 

button. After releasing the button, the point will change its vertical coordinate. 

After correction of points Edit field data, window can be deleted from the main menu. 

To correct the errors contained in the " head " of field data (Name, Tr, Rec, X, Y, Z) it is 

necessary to call editor Edit   Edit set's Head (Fig. 10). 
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INVERSION OF EXPERIMENTAL DATA 

 

Two ways of a section construction on experimental data are included in the given 

package:  transformation and inversion. Let’s consider both ways. 

 

 TRANSFORMATION OF THE CURVES E(t) IN PSEUDOSECTION (h). 

 

To begin with transformation, the initial data E(t) should be smoothed. The data 

smoothing is made by using the method of exponential spectrums [1], namely the nonlinear 

task of minimization of functional  is solved: 

                      
1

( ) ( ) ,   ( ) exp( / )
N

S S i i

i

E t E t E t A t   ,                

i.e. initial E(t) process is approximated by "synthetic" ES(t) function which represents a 

superposition of exponential components with different initial amplitudes Ai and time 

constants i. Norm || ∙ || in (1) is determined as average quadrate of deviations of processes on 

all time interval of measuring. After minimum   is found, i.e. parameters Ai and i are 

defined, initial data E (t) "are replaced" by analytically given, smooth ES(t) function which can 

be multiply differentiated easily. 

Further ES(t) function is transformed to dependence of apparent resistivity on time ES(t) 

 (t). For late times where the requirement of a near zone 1
2L

t
 (here  is magnetic 

permeability,  is conductivity of medium, L is a size of one-loop transmitting-receiving 

antenna) is fulfilled, transformation is described by the formula: 
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where I is amplitude of the current impulse. 

 

 However application of this formula imports essential distortions on small and average 

times where requirements of a short-range band are not observed. Transformation ES(t)  (t) 

correct for any times of measuring can be implemented on the basis of the complete formula 

for transient processes for EMF at one-loop configuration on a surface of the homogeneous 

half-space with resistivity : 

 

 

, 
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The apparent resistivity a can be found for each fixed time t by solving the above-stated 

equation with right member ES(t)=E0(t) for each fixed time t. In result it is possible to receive 

dependence of resistivity f (t) which coincides on late times with a (t).  On early times 

resistivity f (t), calculated on the complete formula (the index f-full), adequately reflects the 

true resistance of the medium (the same as for soundings in direct current methods).  

 For implementation of E(t) (h) conversion it is necessary to calculate correcting non-

dimensional coefficient k(t), depending from logarithmic velocity  of apparent resistivity 

change: 
 

and after that to calculate resistivity  (h), as function of sounding depth h:  

 

The formula for calculation of effective depth h can be modified to 

The function  (res) has dimension [ m] and can vary from f  value - a "not 

transformed" resistivity to =k(t)* f(t)  value. 

Change of values  (res) essentially change form of (h) curve and correspondingly 

resolution of transformation. For a weak contrasting medium  , and for contrasting one 

 f.; for the media with an average contrast level =( h m)
1/.2

. 

 (res) function is regulated by special parameter resolution (res) - « resolution of 

conversion »  

 

The algorithm of conversion and instances of application explicitly are described in 

references [2, 3, 4, 5]. 
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WINDOW FOR SMOOTHING OF EXPERIMENTAL DATA 

 
The smoothing procedure becomes active in window Smoothing - Fig. 11. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 11 

 

The Note: 

It is recommended to use the command Alt+A (smoothes all curves on the screen)  after 

data editing.  

 

 Control elements: 

Limited - the exponential spectrum is positive E (s)> 0 

Free - the sign of exponential spectrum E (s) is unlimited 

Ignore errors - the procedure of smoothing does not take into account the weight 

coefficients defined by lapses of measuring 

Tension - "strength" of smoothing: the more is Tension parameter, the more detailed is 

approximated initial dependence E (t). 

Let's mark, that limitation E (s)> 0 is valid only under condition of the joint receiving and 

transmitting antennas at absence of the frequency dispersion of conductivity and permittivity 

of the researched medium.  

If antennas are not joint or IP-effect occurs, the procedure of smoothing is correct only 

with option Free. 

The instance of smoothing of experimental data is shown in Fig. 11.  
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Upper blue curve approximates the initial data – this is smoothed (t), 

and lower blue curve is calculated dependence f(t ) [ full(t )]. 

In a column of data sets choice one can make active simultaneously all disposable sets 

(Alt+A). After OK the data will be smoothed and transformation (h) and S (h) - distribution 

of a specific resistivity and longitudinal conductance versus apparent depths will be scaled. 

The graphic of (h) and S(h) function can be seen after activation of option (h) of the main 

window (Fig. 12). 

 

 

Fig. 12 

 

 Control elements: 

 Res (h) - to show apparent resistivity (h) 

 S (h)     - to show apparent longitudinal conductivity S (h) 

 Model  - to show the piece - uniform model of the medium (if it is calculated) 

 Transf  - to show transformation (h) or S(h) for preset and calculated the piece - 

uniform  

                  model of the medium (Model window) 

 Design  - makes active mode of construction of new piece-uniform model 

 Log   - to change a vertical scale to logarithmic one 

 Grid   - to show detailed grid of depths and resistivity 

 Resolution - to change the resolution of transformation: the higher is this parameter -  the 

more detailed are curves  (h) or S (h). 
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ATTENTION! 

Transformations E(t)  f(t)  (h) for remoted loops are correct only in near zone 

t/(μ0R
2
/ρa(t)) >> 1 

 

Control elements Model and Transf are intended for the resolution of transformation  (h) 

analysis.  

In particular, change of resolution of transformations at change of distance between 

two thin well conductive clay layers (ρ =3 Ohm-m), deposited within rather high-resistive 

rocks (ρ ~70 Ohm-m) is shown in the Fig. 13. The piece - uniform diagram concern to 

model, and smooth curve - to transformation   (h). 

 

                        h=3m                                  h=10m                              h=30m 
 

Fig. 13 

 

At distance h=3 m the layers are indiscernible, and with increasing of distance between 

layers the resolution is increased. These functions are very useful at planning researches in 

any region in a case when there is preliminary information on structure. 
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SAVING OF DIAGRAMS 

 

The diagrams may be printed, saved in the EMF-file or saved in the PSC file 

(Pseudosection) which is used for construction of pseudo-section at array or profile research. 

There is function File-> Save Image in MetaFile in the menu, which is intended for record 

of diagrams Res(h) or S (h) in the standard OS Windows file (*.EMF is Enhanced MetaFile). 

Having kept the image in this file, the user has an opportunity to insert and edit a figure in 

any text in the form convenient for him. For example, in the MS-programs 

Word/Excel/PowerPoint this procedure looks like: 

Insert -> Image -> from File. 

The program requests size of the figure and a color mode (black- and-white or color image) at 

saving the data in EMF file. Saving the data in PSC file and printing the diagrams is carried 

out by standard for Windows way. 

ATTENTION! 

The legend to figures (only names of field sets) is kept in the case if the switch Info in the 

main window of the program is activated. 

The legend to the figure may be located: 

- in the left top corner, 

- in the left bottom corner, 

- in the right top corner,  

- in the right bottom corner.  

Location of the legend coincides with the location of window Info respectively to 

corners of the main window of the program. 
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DESIGN OF INITIAL MODEL 

 

The initial model can be constructed by two ways: 

1) on the basis of apparent resistivity (h) function, 

2) on the basis of apparent conductance S(h) of function S(h) = 

h

dh
0

1
. 

In first way it is necessary to activate the function Design. After that construct a section on the 

graph of (h) curve using the left button of the mouse by marking nodes as it is shown in Fig. 

14.  

 

 

 

 

 

 

 

                                                                 Рис 14 

 

 

 

 

 

 

  

Fig. 14 

 

At some experience this way provides good approximation of the initial model to a start 

model. As a basis for doing that the recommended boundaries of the layers determined according 

to the extremums of the d2 (h)/dh2 derivative are marked after activation of the Design command. 

In this way the user can more or less correctly to draw resistance of the layers. During this 

procedure we recommend to use the rule demonstrated by the example shown in Fig. 14:  

- the higher resistivity of the layers the function (h) a few decreases, 

- the lower resistivity of the layers the function (h) a few increases. 
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In the second way user first has to enable the options Log and S(h). After that it is necessary 

to make approximation of the S(h) with the piece-linear function using left mouse button -Fig. 

15. 
 

Fig. 15 

 

 For convenience of the editing, the opportunity of correction of the approximation is 

stipulated in the program. For this purpose click with the left mouse button on the unit created by 

you designated by a black square, and pull it in any side, keeping the button. After releasing the 

button, the node changes its coordinate (S and h). In addition, at construction (marking) the nodes, 

pressing the right mouse button delete the last created node. 

 To each piece of the line corresponds a layer in the horizontally - layered model. Thickness 

of a layer is equal to a difference of the ordinates appropriate to two next units, and resistivity of 

this layer: =h/ S, where S is the value of conductance between these units. First layer laying 

just under the earth surface is added to the layers shown on the diagram automatically. For more 

precise design of the preliminary section it is possible to stretch or compress the diagram S(h) 

using the manipulators. 

 Sometimes it is convenient to use both scales at construction of a broken line: linear in 

the beginning of a curve (near to the earth surface) and logarithmic on the late times. After 

termination of the preliminary section design procedure, click the commands Set model -> 

ОК to receive a starting layered model (in the table form it will be shown on the screen 

before loading (Fig. 16). After that it will be automatically loaded into window MODEL of 

the basic menu. 
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ATTENTION! 

Do not forget to mark an appropriate model for loading the created section (color square - 

from red to black, Fig. 16): 

 
                                                              

Fig. 16 
 

It should be noted that the procedure of the second derivative d2 (h)/dh
2
 calculation is 

unstable with respect to errors of the initial data. At small changes (h) (poor contrasting 

section) for correct marking of the borders of layers it is necessary to have small (< 5 %) 

errors of the measurements. If the errors are large, numerous thin layers can appear on a 

curve (h), and at changing the Tension parameter of the smoothing intensity (Fig. 11), the 

picture sharply varies: the part of layers vanish, some change their position etc. It testifies to 

instability of the procedure of the second derivative calculation. In this case it is 

recommended to reduce gradually parameter Tension before occurrence of steady results of 

level-by-level splitting. 

 
INVERSION 

First of all it is necessary to set parameters of the inversion process. For this purpose the 

program provides 4 special windows. 

The tuning window of adjustment - “Attach field data to models”. It is intended for setting 

of conformity between sets of experimental data (field data) and models which will pay off in 

the window “MODEL” at start of the inversion procedure (Invers s). This setting informs the 

program for which set of the field data the inversion is made at activating of any model. 

The window is caused by Setting->Inversion->Attach Field sets to Model (look Fig. 19).



 

Fig. 17 

 

In this case the standard mode (Fig. 17) is activated. In standard mode, the color and number of a 

model corresponds to color and numbers of the field data sets. For example, at start of Invers with 

the active model N 4 (brown color) the procedure of inversion is carried out for the appropriate set 

N 4.  

 However there is an opportunity to configure the model with another way as it is shown, for 

example, in Fig. 18: 

 

                                                            Fig. 18 

In the shown example the inversion procedure is carried out for the field data set N 1 (red 

color) at activation of the models N 1-3, while at activation of the models N 4,5 and 6 - for 

the sets N 2,3 and 4 respectively. Non-standard setting in this window is useful in the cases 

when the user wants to compare the results of inversion of the same field data at various 

initial conditions (parameters of starting model). In usual cases it is recommended to use the 

mode “Set default”. 
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Window MAIN SETTING (Inversion)  
 

 

 

 

 

 

 

 

 

 

 

                                                                 Fig. 19 
 

 Total iteration Steps means amount of iterations of inversion procedures after which the 

result is displayed. Experience shows that usually 10-15 iterations are enough for receiving of the 

acceptable solution. If necessary, one can repeat the process of iterations. 

 Ignore All data Before gives possibility to ignore all points of the curve corresponding to 

times less than the noted (in the real case less than 4 microseconds).  

 Ignore All data After gives possibility to ignore all points of the curve corresponding to 

times more than the noted (in the real case more than 16 microseconds).  

 Use auto protection – provides the ignoring mode of the points on the curve belonging 

to early time corresponding to work of HVP system. 

At activation of the Ignore Error-bars command, the procedure of inversion carries out 

fitting of the model data to the experimental ones without taking into account errors of 

measurements; otherwise the readouts with great errors are used with smaller weight in misfit 

functional, than readouts with a small errors [2]. 

Use cut-off Delay permits to use the procedure for correction of the field data according to 

real switching-off front of the current in the generating loop. In the window Adjust the fine 

tuning of correction parameters is stipulated. 

Regularizing Algorithm is the algorithm preventing the appearance of the thin resistive 

layers in the fitting models. “Low” – the total conductivity of the layer S=h/  [Siemens] is not 

limited,  “Middle”  S > 0.1 S,  «High” -  S > 0.25 S. 
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ATTENTION! 

 

The window “Adjust” is intended only for experienced users! The parameters of 

switching-off current delay are determined experimentally according numerous field 

measurements with different types of cables and size of antennas. These parameters corrects  

the field data with the best way at condition that the transmitting antenna (independently on 

its size) has resistance of 3-8 Ohm and the current in antenna is less than 1.25 A.                 

 

Setting of resistivity and thickness for the Models in the inversion procedure 

The window is caused by Setting-Inversion-Resistivity-Thickness Limits (Fig. 20) 

 

Fig. 20 

 

 Fix columns determine fixing parameters of the model. These parameters are fixed and do 

not vary when inversion the procedure works. In the given example, resistivity of the first layer in 

the model N 1 (red color) is fixed. The value of the resistivity can be seen from the parameter in 

the Model window. 

Columns Min and Max show the minimal and maximal values for the resistivity and 

thickness parameters of the model actual during the work of the inversion procedure. In Fig. 20 

resistivity of the second layer may change within the limits from 100 to 150 Ohm-m. 

«+» provides possibility to control the limits for resistivity and thickness of the layers 

lying below.  
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ATTENTION: if the model’s parameters are fixed, the following indicators are appeared in  

the window MODEL. 

fixed resistivity
of first layer

fixed thickness 
of second layer

 

Fig. 20a 

 

The button  fixes parameters and       cancels them. 

Window for setting of polarization parameters  

 

The window is caused by Setting->Inversion->Polarization’s parameters limits (Fig. 21) 

 

 

Fig. 21 

Here, as well as in the previous case, it is possible to fix or to limit changing of the 

polarization parameters and the constants of a relaxation time.  

It is possible to fix or to release the parameters of dispersion directly in the window 

Model (Fig. 21a) by click by right mouse button onto red painted margin.  
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All possible operations are shown in subsidiary Help window (Fig. 8). Fixation of the layers’ 

parameters is reflected in the panel Model as circles with the color corresponding to a chosen 

model. For example, in shown below case (Fig. 21a), the resistivity of second layer (10 Ohm-

m) and thickness of the first layer (12.5 m) in the model 3 (blue square) are fixed. 

 

 

 

 

 

 

    

 

 

 

                                                           Fig. 21a 

 

Underlined numbers indicate that the polarization parameters are fixed. 

 

ATTENTION: 

 

1.   Setting of limitations on resistivity or thickness of the layers is not indicated in the 

MODEL window. 

2. All possible operations can be seen in the Help (?) window (Fig. 21а, left upper corner 

of the MODEL window). 

 

 

Invers FUNCTION  

 

After definition of a start model and setting of all parameters of iterative inversion 

process, it is necessary to click Invers in order to start process of inverse problem solution. 

Sometimes as a first step it is useful to start up RUN to see how well (or bad) is the initial 

section. If the quality of the initial section does not satisfy you, it is possible to return to the 

window Res(h) and either design new section or to correct parameters of the existing section 

manually having changed number of layers or parameters of some layers, or having inserted  
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or having removed some layers. Sometimes it is useful to fix or put restrictions on that part of 

the section which is fitted well and satisfies you. 

In order to make interpretation of the profile data, it is expediently to do sequential 

analysis of adjacent sites, accepting for the starting model the section, which has been fitted 

in the previous site. For this purpose the panel Model  is used for choice 

of the active model. The left button of the mouse makes active the chosen model. After RUN 

or Invers the appropriate actions for the chosen model are carried out. 

Actions: Pressing -> keeping -> moving -> releasing the right mouse button results in copying 

all parameters from starting (at pressing the button) models to the target (releasing the 

button) model. 

The result of the Invers procedure is described in the left screen’s corner in form of mean 

square deviation of the experimental and model curves of sounding (rms, %). 

 

     Let's consider now the additional opportunities of the MODEL window - Fig. 22. 

 

Fig. 22 

   

This window has the contraction and expanded form. In contraction form (default) only 

7 left columns are shown on the screen. This mode is used for modeling in case of 

frequency - independent resistivity of media, without taking into account IP - effect.  

The standard for WINDOWS “stretch” procedure gives possibility to expand the 

window with the mouse. Besides, the user can exclude some last (deep) layers by reducing 

the vertical size of the window.  

 

 IP - EFFECT 

 

The expanded part of the window is intended for modeling of effects of induced 

polarization IP (sometimes this effect is called as frequency dispersion). The column of IP 

switches mark the layers selected for calculations with the induced polarization effect. 
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The model of frequency dispersion is selected in the window    and can 

can be seen having pressed on the button  . 

   

Fig. 23 

In each layer the user can set “five-component” polarizing model with the different  or , 

time constant  and logarithmic speeds of relaxation с. At that, in the same layer it is possible 

to model jointly the effect of frequency dispersions of resistivity and dielectric permeability. 

ATTENTION! 

The inversion procedure determines only two parameters of IP-effect:  (or ) and the 

relaxation constant . The parameter c is considered fixed (Fig. 23). However, in case of 

complicated model of polarization (for example two or three-component IP-effect in one or 

several layers), the inversion procedure becomes inefficient because of large in number of 

variables. So, one should remember, that polarizing effects essentially extends equivalence 

area of geoelectric section: to a set of experimental data (even in case of laterally layered 

media and small error of measurements) multiple sets of rather various electric parameters 

,  and  can correspond. Therefore we recommend to limit oneself by one-component IP-

effect and whenever it is possible to fix a part of parameters. 
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SPM - SEFFECT 

The inversion procedure does not determine parameters of SPM-effect, they are considered 

fixed. Setting of SPM parameters [6,7,8] is carried out in the window SPM – Fig 24. 
 

 

Fig. 24 

 

Here: 

Roof (m) is the bedding depth of a superparamagnetic layer (distance from the 

earth surface, Roof > 0.01 m); 

Thickness (m) is thickness of the layer; 

kappa (unit SI) is superparamagnetic susceptibility of the layer; 

Change of a symbol’s form in the line Model (see Fig. 22) indicates existence of SPM 

effect in the media. Here in the example case:                                           the model 1 and 3 

contain SPM-effect. The button Delete deletes SPM-effect from the model, Insert - 

establishes it.  

 

SAVING OF THE INVERSION RESULTS  

After completion of the inversion process, it is necessary to save the received results in a 

file. For that, you can select the File->Save Inversion’s results, correct the names and 

coordinates, then these data are saved into INT-file – Fig. 25. 

If you need to read the information from NT-file and to set parameters in the window Model, 

use File->Input Model data Res(h) function which opens INT-file. Select the model you need 

(Fig. 26) and using Install button insert the needed parameters in one of six modeling cells. 
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Fig. 25 

 

 

Fig. 26 

 

 

ADDITIONAL FUNCTIONS FOR DATA SAVING 

1. Saving (t) and E(t) calculated on the basis of layered model. 

After calculation of (t) and E(t) (Fig. 27), it is possible to save the data in Tem-format (as 

for the field data) or in free format (ASCII) for further use in any electronic table (for 

example, MS Excel) using the function File->Save model curves E(t)->TEM-FAST format 

(or General-purpose style). 
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2. Editing and saving of the field data 

  After redaction and smoothing of field data, one can change the names, coordinates, or 

antenna´s size and save them to TEM-file using the scheme shown in Fig. 28: 

 

Fig. 28 

 

PRINITING AND COPYING OF THE GRAPHIC DATA 

All main windows of the program have a menu´s section (Fig. 29) intended for operation 

with graphic information: printing of graphics and copying. 

 

Fig. 29 

Fig. 27 
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The function Save Image in *EMF is intended for inserting in a standard OS Windows 

file (*.EMF – Enhanced MetaFile). Having save the graph in the file, a user has possibility to 

insert the picture in any document in workable form. In MS Word this procedure is:  

Insert -> Image -> from File. 

At saving graphs in EMF format the program inquires the size and color (black-white or 

color image). 

Print, Print Preview, Page Setup commands are standard Windows functions, providing 

capable setting of the printing parameters: page size, preliminary view etc. 

 

CONSTRUCTION OF GEOELECTRIC SECTIONS 
 

For construction of geoelectric (a horizontally-uniform layered medium) or pseudo-section 

(gradient resistivity section), it is necessary to have: 

- the data received at profile or array measurements (TEM-file); 

-  the inversion’s data received in result of  inversion procedure and saved in INT-file (for   

   geoelectric sections); 

- the results of transformations (t)-> (h), received in window Res(h) and written in PSC- file 

(for pseudo-sections) 

ATTENTION! 

1. At the first stage of array and profile data interpretation, check up and modify coordinates 

X,Y,Z of sounding sites! 

2. TEM-RES v.8 supports formats of INT-files TEM-RES v. 4 (DOS), however inquires a 

size of the transmitter antennas used at measurements. 

 

Command Section->New of the main menu causes file dialogue with the help of which it is 

possible to open either INT or PSC file containing the results of inversion or transformation 

along of all sites of the profile or area. 

The window containing the INT-file´s information on coordinates of the field sites, 

existence or absence of IP and SPM effects is represented in Fig. 30. 

In column = the sets with identical coordinates (X andY) are marked. If those are present, 

it is necessary to choose a unique set convenient to your requirement (the program of 

section´s construction does not suppose duplicate sets of the data). 
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Fig. 30 

 

Double click by the left button on any data set, and detailed information on a sounding 

site (Fig. 31) which can be edited will result. 

 

 

Fig. 31 

 

Click the Select All command (Fig. 30) and mark the window Map. You will see the 

location of points of soundings on a topographic map (Fig. 32).  
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Fig.  32 

Here the following denotes are used: 

Style – changes the style of the map 

Math - X-coordinate increases from the left to the right, 

            Y-coordinate increases from the bottom to the top; 

Geo -   X-coordinate increases from the bottom to the top, 

            Y-coordinate increases from the left to the right; 

Grid - sets the grid with different mesh sizes; 

Labels - displays the serial number of the point of sounding as it is shown in Fig. 30; 

Symbol - indicates the point of sounding in a square form; 

Altitude - Altitude shows Z coordinate of sounding location; 

Name - displays the name of the point of sounding (Set Name); 

Stratify - activates the procedure for constructing fiber wise horizontal slices resistance; 

Design mode includes the construction of the profile, along which you want to build a vertical 

cross-section resistances; 

Click the left mouse button on the points that you want to be included in the profile, for 

example, as shown in the left panel of Fig. 33.  
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Fig. 33 

 

If you made a mistake and didn´t not include the point that you need, press the right button 

and your last action is canceled.  

To construct a profile you can draw a straight line or broken line near the points to be 

included in the profile (press and hold the left mouse button), as shown in the right pane in 

Fig. 33.  

Once all the necessary points are marked, i.e., profile is created, double click the mouse 

button to end the process of building the profile. The menu is displayed Set PR that means 

«set profile", and point of the profile will turn red.  

If the data is only one coordinate (for example, only X, and Y at all points of the same  

profile), the profile is automatically represented on the screen after the activation of Design.  

 Click Set PR, and display show the created profile (Fig. 34).  

 

Fig. 34 
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By default, the profile depicted as Logging (logging) style, i.e., as a horizontally-

layered medium. The horizontal scale of the resistivity Res (h) is logarithmic. 

Below there are two control elements:                                                                     , you can use 

them to change the position and scale of the Res(h) graphs. In parentheses is shown the 

magnitude of the resistivity corresponding to position of the vertical line marker that is 

present at each point sensing. 

Going into the View menu, you can change the style of the image into as Tomography, and 

to see a section in color (Fig. 35).  

 

 

Fig. 35 

The similar figures can be obtained by opening the files from the PSC-transformations.  
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Fig. 36 

 

As a result of loading of a SEC file containing the information on both the 1D inversions 

and transformations, the menu in the window Section expands to six positions and allows you 

to build six different sections (Fig. 36a):  
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Fig. 36а 

 

- The transformation in the form of curves - Transformation (Logging); 

- Transformation in the form of a color palette - Transformation (Tomo); 

- Transformation  in a color palette form with the 1D inversion data - Transformation & 

Inversion;                                   
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- 1D inversion of a color palette form with the curves of transformation - Inversion &  

         Transformation 

- 1D inversion in a color palette form of Inversion (Tomo), 

- 1D inversion in the form of a horizontally layered models of Inversion (Logging)                                   

The user can change a title of the section and the font, for that it is necessary to double-

click the left mouse button on the title (SECTION # 2, for example) 

By clicking the left mouse button on "Distance, m", the user can change the labeling on the 

profile distances signatures, remove them or flip the cut (left-right to change).  

                                  

 

By clicking with the left mouse button on “Altitude, m” you can call the window 

 

 

 

Here you can set elevations of all points on the section to a convenient level (i.e., remove 

the relief) or to move all the points of the profile at the selected value (i.e., add or subtract any 

level). You can also return to baseline levels of elevations (axis Z).  

      To correct the color palette of the scale of resistances click twice on the scale ruler on 

the right side of the figure - Edit dialog appears (Fig. 37).  
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Fig. 37 

 

The control elements to the left of the color scale palette let you edit the resistivity. 

Possible coloring scales (6 options) are shown at the bottom of the window. Click the left 

button to select the color option. Scale (maximum and minimum) column of resistivity is 

selected automatically. However, in some cases the user can set a specific range of resistivity 

values. Such need arises at the comparative analysis of sections obtained at the same area of 

research. In this case all sections and the corresponding maps (see the section "CREATING 

MAPS OF RESISTIVITY AND CONDUCTIVITY") it is conveniently to represent in a 

single palette. To change the maximum and minimum values of the resistivity double-click in 

any point to the right of the Color column, and after appearance of the window " Define Ro 

max/min", enter the required parameters. Similarly, you can change the scale of the resistivity 

maps (Fig. 45). 

After clicking the Apply button, the section will be rebuilt in accordance with the selected 

palette. 
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REINTERPRETATION OF THE DATA 

 

 

 

In some cases, after the construction of the sections is that the results of the inversion or 

transformation at some points need to be corrected because of errors of interpretation or of 

poor quality input data. In this case, a procedure for re-correction, data transformation and 

inversion. 

In order to re-edit, to make 1D inversion, or transformation of the data, double-click the left 

mouse button on one of the vertical lines, as shown in Fig. 38. The data from the section are 

recompiled to the main window. To edit them it is necessary to open the window Edit Field 

Data and prepare to re-inversion, as shown in Fig. 39 

 

 

 

 

 

 

 

 

Fig. 38 
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You can repeat the inversion procedure, by simplifying or complicating the structure 

of the section and limited ranges of resistivity and thickness of the layers according the 

structure of sections in the neighboring points. You can add the polarization effects, or to 

remove some points from the curve. After activating the RUN or Invers functions 

automatically change the section at the selected point (043 in the example) in accordance with 

the new model of the medium. 

If you are not satisfied with the re-inversion, go to Undo and cancel your actions, or remove a 

set called 043 from the buffer of the field data. 

In the example shown in Fig. 40, adjusted six points were corrected, but the correction 

was satisfactory only for 1, 3, 4 and 6 points. In the second one and fifth point re-inversion 

was not successful, and the results can be canceled (Undo), and the point itself can be 

removed from the buffer of correction (Delete) (however, this point is not deleted from the 

section!).  

 

 

 

Fig. 39 
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Fig. 40 

 

If the section is constructed using the data from Psc or Sec file, you can edit the tem-data 

(sounding curves) and restart the procedure for smoothing, and then, opening a window 

Res(h), repeat the transformation using the old or new settings.  

 

Fig. 41 
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After correction, the geoelectric section can be:  

- Printed on a printer (Print, Print Preview) 

- Saved as emf-file (Save Image in *EMF) 

- Stored as INT or PSC or SEC files (Save Section) 

- Saved as a text file (Save as txt-data) for use by other programs. 

-  All of these features, see in the menu File. 

 

 

Fig. 42 

 

ATTENTION:  

Before using the procedure of copying the screen with a section it is recommended to hide 

the control elements by pressing Alt+T, and then use the Print Screen. 

Once work with the section is completed, you can either remove the section of the program or 

leave it in the buffer that would later continue to work with it. Both operations are performed 

by pressing the Exit command or ×                  .   

The program asks: "Do you want to remove the section or not?" If you answer "YES" the 

section is removed from the program. If you answer "NO" the section is placed in the buffer, 

whose contents can be seen in the main menu (Fig. 43).  

To call from the buffer it is enough to click on the desired menu item (in this example, 

Section 5, Section 6), and the section will once again be on the desktop of the program. This 

operation is almost completely analogous to minimizing of the window 

At the same time, the user can create up to 5 different sections.  
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Fig. 43 

If the buffer containing the sections is full of cuts, it is necessary to remove an 

unnecessary incision and in its place a new one. Use the dialog "Delete Section" to remove 

the cuts.  

    

Fig. 44 

 ATTENTION! 

Repited adjustment inversion (reinterpretation) is possible only for data of INT (2002 

format) or INT/ PSC/SEC for files recorded in the format of TEM-RES v.7 (2008-09). 

If you have INT-files in TEM-RESEARCHER-DOS format (written before 2002 year), 

we recommend you to reformat them into a new format. To do this, download both the 

corresponding TEM-file with the original data and INT-files with the results of the 

inversion (input Model data), to establish a correspondence between sets of soundings 

and the models run Invers and after the inversion to save the results in the INT-file 

(Save Inversion's results).  

 

 CREATION  OF THE RESISTIVITY AND  CONDUCTIVITY MAPS 

 
 

After opening the PSC SEC or INT files containing data on array studies (Fig. 30), 

the user opens the Map (Fig. 32), which depicted a map of plotted soundings´ points. Click 

Stratify and in the appeared window specify the position of the roof (Roof) and bottom 

(Floor) of the layer, the average resistivity of which are of interest for you (in this case - Fig.  

45, "cut" is made at depths ranging from 35 to 45 meters above the ground). For assistance, 

see “?”. Click the OK.  
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Fig. 45 

 

This example illustrates the "electromagnetic image" of a paleovalley. 

Zones of low resistivity (blue) correspond to the clay and silt deposits and zones of high 

resistivity (green and red) are localized sands and conglomerates (demo_map.psc file contains 

more than 1,500 sounding points and applied as a demonstration). 

Each shaded square on the map corresponds to the actual size of the used antennas (loops). 

Loop size window is used to display not scaled loop antennas with rare, irregular location of 

sounding points.  

 

INCREASING OF THE MAP´S FRAGMENTS 

 

 Holding the left mouse button, draw a rectangle; after clicking by the right button the 

selected fragment of the map will be increased. Zoom out command is intended to return it in 

initial state.  

Clicking the Save button you can write the characteristics of the layer (resistivity   

and the conductance S) in the MAP-specific file (the file format is described below). 

  You can then use these data to construct maps using any special programs, for example, 

Golden Surfer. 

Map window allows the user to save a color map of the resistivity in the Windows MetaFile 

(EMF) and then paste the picture into the document MS Office package. Use the menu Save 

Image in * EMF and after determining of the image´s size and file name save the image. 

IFig. 46 shows a resistivity map for the layer 0-20 m, created in the window Map, stored in  
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the EMF-file and pasted into MS WORD. THE map corresponds to the example shown in 

Fig. 45, but for a different cut-off level (file demo_map.psc).  

 

WARNING! 

1. To change the scales in the color range it is necessary to use the methods of Fig. 37. 

2. For full color at the construction and writing maps and sections in the MetaFile it is 

necessary to set the video adapter "Color palette" High Color (16bit) or True Color 

 (32 bit). 

3. The minimum allowable RAM of your PC has to be at least 512 MB. 

4. The operation of saving the image to the Windows EMF sometimes requires closing 

all or part of the active applications 

 

  SAVING OF THE DATA IN THE “SECTION” WINDOW 

 

The data with information on the resistivity section, you can save three different 

formats (Fig. 47)  

ные,   

RESISTIVITY  OF  LAYER (0 -20 m)

7000

6500

6000

5500

5000

4500

4000

3500

3000

2500

-7
5

0
0

-7
0

0
0

-6
5

0
0

-6
0

0
0

-5
5

0
0

-5
0

0
0

-4
5

0
0

-4
0

0
0

-3
5

0
0

-3
0

0
0

-2
5

0
0

-2
0

0
0

-1
5

0
0

-1
0

0
0

Ohm-m

1K

100

10

7

 

 

 

Fig. 46 
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Fig. 47 

 

Save Section → with Original XY- saving of the data in INT or PSC / SEC format with the 

coordinates that were at the measuring points before they were included in the section (e.g. 

GPS coordinates).  

Save Section → as Profile line - saving of the data in INT or PSC / SEC format with 

coordinates corresponding to the profile, which is present on the screen. 

Save as TEM-data → with Original XY- saving of the data in TEM format with the 

coordinates which were at the measuring points before they were included in the section (e.g- 

GPS coordinates). You can again carry out the procedure of smoothing and other activities 

with these TEM-data. (available if downloaded files are in 2008 format) 

Save as TEM-data → with Original XY- saving of the data in TEM format with coordinates 

corresponding to the profile, which is present on the screen. (available if downloaded files are 

in 2008 format)  

Save as txt- saving of the data in a special text format suitable for the construction of laterally-

uniform layered model in an electronic tables:  
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Text data can be used to compare the results of TEM inversions and well logs (Figure 49):  

 

Fig. 49 

 

 

 

 

Fig. 48 
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SAVING THE RESISTIVITY MAPS  IN ENHANCED METAFILE (EMF) 

 

Maps of the resistivity (Fig. 45) and sections (Fig. 42) can be saved as images in 

Enhanced MetaFiles of WINDOWS system (EMF-Enhanced MetaFile). 

When you invoke File-> Save Image in * EMF the menu appears (Fig. 50a (Box Section) 

and Fig. 50b (Box Map)  

 

 

Fig. 50a 

 

 

Fig. 50b 

 

The user can specify either the size of images, or the scale of the Graphs (Scale) Image 

size is determined by the frame limiting the section or map without axis labels, etc. (Fig. 51).  

By setting the needed size, go to the Scale 1, set the scale (1:5000 for example) and go to the 

Width - the appropriate parameters set automatically. 
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Fig. 51 

 

DATA CONVERSION 

 

The program TEM-RES provides several types of data conversion. 

When entering data in the main menu File-> Input Field Data you can download the 

sounding curves from TEM (text or binary) files or from the INT/PSC/SEC files (format 

2008). Next, open the Map (Fig. 52 - SEC file is open).  

 

 

Fig. 52 

 

To edit the test information within the set of soundings - double click with the left mouse 

button on the right square on the map. If you want to save in a new file (make converting) 

only part of the sets represented on the map, you need to move unwanted sets in "inactive" 

state by double click with the, right button on the appropriate box on the map (inactive sets  
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painted in gray color). If you want to do inactive at once a lot sets in a large area of the 

map, you must act as described in Fig. 4b.  

With the help of Save Sets menu one can save into a new file all active sets in the formats:  

- TEM (text) with downloaded file of any type (TEM-txt, bin, INT / PSC / SEC);  

- INT – with downloaded file of INT or SEC type;  

- PSC - PSC with downloaded file or SEC type;  

- SEC - SEC file with downloaded SEC type.  

The order sets in the file corresponds to the procedure established previously (Fig. 52 - a 

list of sets)  

 If the INT / PSC or SEC file opens in the main menu as a Section-> New, then after 

loading, the screen appears as shown in the left side of Fig. 53.  

 

Fig. 53 

 

Double click on Set data allows you to open an editing window shown on the right side of 

Fig. 53.  

After editing the data it is necessary to note the sets to be recorded (converted) into a file 

and go to the menu Save as.  

The files can be written in the following formats: 

- TEM (text) - for any type of downloaded file: (INT / PSC / SEC);  

- INT – for INT or SEC type of downloaded file;  

- PSC – for PSC or SEC type of downloaded file ;  

- SEC – only for SEC type of downloaded file.  
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FORMATS OF THE FILES 

TEM-file (text) 

TEM-FAST 48 HPC/S2  Date: Wed May 07 10:58:59 2001 

Place: SEVASTOPOL-01 H-way SEV-YALTA 

#Set  FF-01-SEV-JA        

Time-Range  5 Stacks  15    I=1.0 A  FILTR=50 Hz 

T-LOOP (m)  25.000  R-LOOP (m)  25.000  TURN=     1 

Comments:   landslide 18km S-YALTA 

Location:x=   +16622.000  y=   +36536.000  z=   +93.00 

Channel Time[ s] E/I[V/A] Err[V/A] Res[Ohm-m] 

 1   4.06   8.291e-001 7.965e-003     43.64  

32 956.53   2.737e-005 2.091e-006     4.01 

 

INT-file (format 2008) 

#GEOSEC: 001A /50/50/1./490245.000/ 3930191.000/2.0/36/3/0/21030 SPM=0 K=0 H=0 DH= 0/rms=2.29 

S  [V/A]:  +5.004e-002 +4.589e-002 +1.582e+000 +1.702e+000 +1.223e+000 +9.911e-001 +8.311e-001 

Err[V/A]:  -3.808e-005 -2.374e-005 -2.447e-004 -3.664e-004 +1.000e-010 +1.113e-004 +1.869e-004  

300.0000      2.88 

4.2435     22.78 

0.7164 100000.00 

<Date: Wed May 28 07:06:56 2008 

<Time Range=6 Currrent= 3.70 Stack= 5 Filter=50 Deff=    6 Ampl=OFF 

<Remark: NEXT TO NATIONA                

<Place: LIDL PLATANIA                  

<**************************************************************************************** 

PSC-file (format 2008) 

#TRANSFORMSEC: 001A   / 50.0/  50.0/   1.0/  490245.000/ 3930191.000/   2.0/36/4/  773 

TrueRes  [Ohm-m]:      +69.976     +48.626     +37.719     +31.011     Derivative [log]:       

0.500      -0.500      -0.499      -0.498      -<Date: Wed May 28 07:06:56 2008 

<Time Range=6 Currrent= 3.70 Stack= 5 Filter=50 Deff=    6 Ampl=OFF 

<Remark: NEXT TO NATIONA                

<Place:  LIDL PLATANIA                 

S  [V/A]:  +5.004e-002 +4.589e-002 +1.582e+000 +1.702e+000 +1.223e+000   

Err[V/A]:  -3.808e-005 -2.374e-005 -2.447e-004 -3.664e-004 +1.000e-010    

<************  AUTO TRANSFORMATION ****************** 

SEC-file (format 2008) 

#TRANSFORMSEC: 001A         /  50.0/  50.0/   1.0/  490245.000/ 3930191.000/   2.0/36/4/  773 

TrueRes  [Ohm-m]:      +69.976     +48.626     +37.719     +31.011     +24.946     +19.723     

Derivative [log]:       -0.500      -0.500      -0.499      -0.498      -0.497      -0.495      

<Date: Wed May 28 07:06:56 2008 

<Time Range=6 Currrent= 3.70 Stack= 5 Filter=50 Deff=    6 Ampl=OFF 

<Remark: NEXT TO NATIONA                

<Place: LIDL PLATANIA                  

S  [V/A]:  +5.004e-002 +4.589e-002 +1.582e+000 +1.702e+000 +1.223e+000 +9.911e-001 +8.311e-001 

Err[V/A]:  +3.808e-005 +2.374e-005 +2.447e-004 +3.664e-004 +2.000e-010 +1.113e-004 +1.869e-004 

<1D INVERSION: N_Layer=3 IP=0 IP_Codes=22222 rms=  2.29 

 300.0000      2.88    4.2435     22.78    0.7164  100000000.00 

 

<************  AUTO TRANSFORMATION OF 1D INVERSION ************************* 
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MAP-file (format 2008) (Roof and Floor of the layer are included in the file´s name 

authomatically) 

# Name     X(m)      Y(m)      Z(m)    Ohm-m)  S(1/Ohm) log10(Ohm-m) 

Log10((S/m)rms% 

1 sj-01   16622.0   36536.0    93.2      9.390   5.32481    0.3     1.2      3.4 

 

MAP_E- file 

#   NAME       X            Y            Z        t=4.06 s        t=5.07 s 

              (m)          (m)          (m)         V/A          V/A …….  

1  sj-02    16599.0      36542.0        97.0   +6.76e-001   +4.15e-001 ….   

2  sj-03    16589.0      36552.0        99.0   +6.86e-001   +4.35e-001 ….   

3  sj-04    16549.0      36557.0        92.0   +6.26e-001   +3.35e-001 ….   

 

This option is available only in the extended version of TEM-RESEARCHER v8, 

available on request. CONTENT FILE window is of the form -Fig. 54 

 

Fig. 54 

Click Auto Inversion and a display map with the points of soundings available from the 

public TEM - file (Fig. 55) will arrived.  

 

 

 

 

 

 

  

AUTOMATIC INVERSION OF LARGE DATA SETS



 60 

 

Fig. 55 

 

The red color denotes the set of soundings from which by default the process of inversion 

will begin. The curve ρ(t), corresponding to this point is highlighted in the main panel. The 

user can change the initial (starting) point of the process by clicking the left mouse button on 

any set (square) on the map. Next, he must set the "horizontal" and "vertical" limits within 

which inversion of the data will be carried out (Fig. 56).  

 

Fig. 56 
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Now, the points of the curves beyond the blue rectangle of  Fig. 56 will be ignored in the 

inversion process.  

Another mandatory procedure before the start of the automatic inversion sets the limits for 

resistivity and thickness of the sections´ layers (Fig. 57).  

 

Fig. 57 

Next, you need to choose a starting model of a layered medium and determine the number 

of layers, whose parameters are calculated in the inversion process. This procedure has been 

described above: Smoothing-> Res (h) -> Design-> definition of the number of layers-> 

Set in Model-> Invers.  

Note that such large number of set parameters is absolutely necessary for the automatic 

inversion procedure. If these settings are too arbitrarily, then most likely that the procedure 

will go into a dead end and you get nothing useful. For professional work with this option of 

the TEM-RESEARCHER program, one has to have experience and good knowledge on the 

geoelectrical structure of the area under investigation.  

So, if you-created a set of constraints of ρ(t);  

 - imposed restrictions on the resistivity and thickness of the layers;  

- determined the number of iterations required for high-quality selection of the section´s 

model,  then the automatic inversion procedure is ready to work.  

The main idea behind the base of this procedure is that the starting model for inversion at 

the sounding point "A" is identical to the final model point "B" if the point "A" is at the 

minimum distance from point "B". Thus, starting from the initial point, the inversion 

procedure is "looking for" the nearest point and starts sounding the inversion process with a 

starting model taken from the result of the inversion point of the previous soundings.  
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Fig. 58 

 

 In the current pause the user can change all the parameters set prior to the automatic 

procedure of inversion: the number of layers in the model, resistivity and thickness of the 

layers, all restrictions on the magnitude of the resistivity, the time range and etc. The user can 

open the Edit Field Data and make "correction" of the field data, removing the clearly 

erroneous point on the curve ρ(t). Some parameters of the section can be fixed (or "free"), (to 

activate fixation and correction of these parameters, click Run!)  

After all the changes, click again the Start button and continue the inversion of the 

sounding point at which the procedure was interrupted.  

The effectiveness of the automatic inversion depends primarily on the quality of the field 

data, uniformity (or variability) of electrical parameters of the medium and how optimally 

chosen the restrictions on the parameters of the layers.  

 In some cases it is possible to produce the correct inversion in the automatic mode on an 

area of more than 5,000 points of soundings with less than 5% unusable. For manual 

operation of the inversion of such amount of data would require at least 100-120 hours of 

work, while, as an automatic procedure fulfilled this work without operator intervention for 8 

hours.  

With a relatively small data set (up to 100-200 sounding points) appropriate to use the 

above procedure in a semiautomatic mode, i.e. with pauses and correction of the inversion 

parameters and editing the original data. In semiautomatic mode, it is advisable to open 

multiple windows at the screen, as shown in Fig. 59.  
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Fig. 59 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It should be noted that even if in an automatic or semiautomatic inversion you are not able 

to obtain a acceptable result in some points in the profile or research area (due to errors in 

input data, for example), it can be corrected. After the inversion it is recommended to load 

INT-file and draw geoelectric section (or set of sections in case of area measurements) and 

reinterpret the data, as previously described in the relevant chapter.  



 

 

 

 

APPENDIX 

When using the TEM-48-900 program to work with the device on tablets without a mouse or pen 
(stylus), on which the control buttons are small in relation to the finger and it is difficult to press 
them correctly, it is proposed to call the Big Buttons and hide them after use. This trick �greatly 
facilitates the work with the program. 

 Main Window

One click on the specified area 

Window view

Double click on the center of the screen to increase/decrease the control buttons
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Work with the WIN 32/64 TEM-48-900 program without a mouse and stylus



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Double

Click

Double

Click

Transformation Window - Res(h) 

Double click on the center of the screen to increase/decrease the control buttons 
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